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PURPOSE 

The Fusion suite of applications share a set of databases (Central, Fusion Remote, Local) and it is with 
the Fusion Administrator application that the customization of tables, management of users and 
groups, and configuration of modules is completed. This administration is completed in the single 
Central database.  DHLogger and Sample Station handle the distribution of changes, both structural 
and data, to the other databases. 

 

PREREQUISITES FOR USING THE APPLICATION 

USER PROFILE PERMISSION 

Accessing the Fusion Administrator application should be done by users that have the Administrator 
User Profile. This can be assigned in the User Administration window within Fusion Administrator. 

 

DATABASE CONNECTION 

Fusion Administrator is meant to be used against the Central database, but in some organizations, it 
may be used while connected to a Standalone (Local) database.  

 
 

  



 

3/31/2023 Fusion Administrator 6 
 

CUSTOMIZATION OF TABLES 

OVERVIEW 

 

 

The Fusion database structure contains configurable tables that fall into one of 2 categories: Data 
Tables and Reference Tables. 

DATA TABLES 

• Used to store user-entered records 

• Link to reference tables to ensure Referential Integrity (RI) 

• Standard (built-in) and Custom tables are available 

• Standard tables can have columns added to them 

• Standard tables do not have to be used 

• Custom Tables are created when the standard tables are not sufficient for logging needs 

REFERENCE TABLES   

• Tables that store picklist items 

• Used within data tables 

• Standard (built-in) and Custom lists are available 

• Standard picklists are used in the built-in tables and the collar screen 

• Standard picklists have been made for items common to most clients   
o e.g. Rock Type, Texture Type 

• Custom picklists can be created when the standard picklists are not sufficient for all data 
capture needs 

• Custom picklists are stored as REF_TableName 
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CUSTOMIZING A DATA TABLE 

Customizing a standard (built-in) data table and 
creating a custom data table are both performed in 
the Custom Tables module, accessible from this tile, 
or [Maintain > Define Custom Table...] menu. 
 

 

 

From this window, you can access Custom Tables, Standard Tables and LAS Tables.  You can create new 
custom tables, or customize any table by adding new columns, editing existing columns, and deleting 
custom columns.  As well, you can access a window to create groups out of Standalone tables. 

 

With "Custom" selected as the Table Type, use the New button on the toolbar to create a 
new custom table. 

 

With a table selected, using the New From button on the toolbar will copy an existing 
table's settings and column definitions.  You will be required to give the table a new 
name (it defaults to "NEWTABLE"). 
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At this point, the new table is not yet created as column definitions must be added first. 

 

Use the Add Column button to add column definitions to a table.  If the table 
has already been created, the column will be added to the physical table; not 
just to the table's definition in preparation for table creation. 

•Table Name: physical name of the table (will be automatically prefixed with UDEF_)

•Comments: description of table

•Tab Title: title that will be displayed on the tab ***

•Template: There are 2 Oriented Core templates, each with the same columns that are 
automatically included, and are required for OC calculations; and 2 templates that match the 
table structure of tables used in Core Profiler

• OC - All: uses survey records of all types in the OC calculations

• OC - Ranked: uses only the survey records that have the highest ranking test type

• CP Core: columns match those in Core Profiler's Core Units table

• CP Defects: columns match those in Core Profiler's Defects table

•OC Calculation Method: There are 3 methods for performing the calculations on columns within 
tables created with either of the OC Templates ***

•Simple: calculates with OCore.dll

•Simple, Line and Plane: calculates with OCore.dll, Line and Plane columns calculated

•Core, Line and Plane: calculates all columns

•Style: Grid / Form layout ***

•Relationship: whether the table is a Drill Hole table, Interval table (will link to Major / Minor 
intervals and have depth constraints based on their depths), Sample Station table, or Standalone 
Table

•Allow Overlaps, Allow Duplicates, Allow Gaps: validations on Depth_From, Depth_To columns 
***

•Data must start at zero: validation (table's data must have a Depth_From = 0) ***

•Create Deafult Row: an interval-related table setting, when Major/Minor is added, a new row is 
added to this table with same depths ***

•Perform Desurvey: an option available to custom tables, which will add a specific set of columns 
during table creation, and allows for the storage of the results of a Desurvey of the Drillhole

•Parent Table Name: a pick list, available for Standalone Tables only, that links tables in a 
parent/child relationship. Only standalone tables that have a unique key defined will be available 
as a Parent

*** Business Unit preferences may override these settings, applicable to Sample Station UDEF 
tables only (as DHLogger now shows List and Form, and Standalone Tables are GRID only)

Table Details
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•Column Name: physical name of the column in the table

•Column Title: custom label for the column ***

•Data Type,Total Width, Precision: column's definition details

•Column Style: Edit / Dropdown with FK  (picklist)

•Lookup Table, Data Column, Display Column, Lookup Style: picklist settings 
available when you have selected "Dropdown with FK" style ***

•Decimal Places to Show: setting to control the appearance of numeric columns 
in data enty windows ***

•Default Value, Min Value, Max Value: default value for the column, and for 
numeric columns, Minimum and Maximum values used in validation during data 
entry ***

•Depth Increment, Value: setting, visible only for "Depth_To" columns; allows 
for specification of default intervals  (enable, then set the Value; eg. "5" would 
create 0-5 for first row, 5-10 for second row; "0" would create copy of first row's 
depths)

•Context-Sensitive: setting, available when you have selected "Dropdown with 
FK" style; would indicate that the values in this column's picklist are dependent 
on the value entered in another column that has a picklist; within the 
configuration, the column that provides context can vary by Business Unit

•Edit Style: (none) / checkbox style; DateTime / Time Only - 24 hour / Time Only -
am-pm

*** Business Unit preferences may override these settings

Column Information

•Is Required: determines if the "field" can contain NULL or not (on-screen 
validation only, as the column remains nullable in the database); if a column will 
be identified as part of a unique key (standalone tables), it must be required ***

•Display Column: whether or not the column is visible ***

•Inherit Values: when enabled, this column will contain the same value as the 
previously created row  (does not apply to DRILL_HOLE columns) ***

•Overlap, Dup, Gap Validation: dependent on Table Configuration, additional 
columns can be included in determining whether a row is a duplicate (or gap or 
overlap) ***

*** Business Unit preferences may override these settings

Validation Information

•Calculation Formula: if a calculated column is needed, simply type or drag/drop 
operatons, functions and columns into this field; validation of the formula 
occurs before saving, checking for correct syntax; do not use another calculated 
column in a formula

Calculation Information
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The Delete Column button will delete a column's definition from a not-yet-
created table, or it will drop a column from the physical table when the table 
has already been created.  There are some cases where columns are not 

allowed to be deleted.  For example, columns that are in use by a Calculation Formula;  Depth_From or 
Depth_To in an interval-related table; and columns that are added when the table is defined with from 
a Template. 

 

Once the table definition and all the column definitions are complete, use the 
Create Table button to issue a command to the database to create the table.  

This will also add the statements to the COMMON_SQL_STATEMENTS table so that the table will be 
created in the Fusion Remote and/or Local when the databases are synchronized. 

Once a Standalone table has been created, you have the option of adding a 
Unique Key to the table, composed of any of the required (non-null) columns 
that were defined. 

A key can also be changed or removed, using the Edit Key button (which 
becomes visible only when a key is created). 

 

When a new data table is created it will need to be added to the appropriate Logging Styles if Logging 
Styles are used.   

When new columns are added to existing tables, they may need to be associated with Logging Styles, if 
‘Limit Columns by Logging Styles’ is enabled. 

 

 

This button accesses a window that allows for the creation of Groups, to 
be used when logging Standalone tables that are related to one another 
in a Parent / Child organization. 
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•Group Name: name for the group of related tables

•Module Name: name of the module to log samples

•Parent Table Name: picklist containing tables for which child tables have been defined

Standalone Group

•Available Tables: once the Parent Table has been chosen for the group, the list of 
available tables will be filtered to display only those that are defined with the parent 
table. It will also show modular_samples table if module name has been entered for this 
group

•Selected Tables: the tables that will be grouped together in the Log  > Standalone Tables 
module. If modular_samples table is selected, you can choose to either show depths for 
samples or hide them. They are set to visible by default.

Group Tables
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CREATING A CUSTOM REFERENCE TABLE  

Creating a custom reference table is performed in 
the Custom Reference Tables module, accessible 
from this tile, or [Maintain > Custom Reference 
Tables > Define Reference Tables...] menu. 
 

 

 

 

Clicking on the New toolbar item or the Add button in the window will create a 
new table, pre-set as REF_NEW, which can be renamed. 
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Switching to the "Columns" tab and clicking the Add Column button will 
allow you to customize your new reference table to suit your needs. 
Continue to add columns by filling out the column information and clicking 
the "Add Column" button.  

When all column definitions are finished, click the "Apply" button. 

 

Switch back to the "Table" tab to click the "Create Table" button. 

 

 

 

 

MAINTAINING DATA IN A CUSTOM REFERENCE TABLE  

Maintaining the data in a custom reference table is 
performed in the Manage Data module, accessible 
from this tile, or [Maintain > Custom Reference 
Tables > Manage Data...] menu. 
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Select the custom reference table from the Table Name dropdown.  The window will be drawn with the 
columns you defined, plus an additional "Colour Number" field. This field is used to associate a colour 
with the reference code, for use with the Graphic Log in DHLogger.   

Use the Insert and Delete buttons to add and remove entries from the reference table. 
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MAINTAINING DATA IN STANDARD REFERENCE TABLES 

The standard (built-in) reference tables are maintained in separate windows, accessed from individual 
menu items.  The main menu item that provides access is [Maintain > Reference Tables] 
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USER MANAGEMENT 

OVERVIEW 

 

 

 

USERS  Each user of the applications in the Fusion suite will have their own account maintained with a 
User ID and Password.   

 

BUSINESS UNITS  A company that operates globally may find that users in North America log data 
with different reference codes, validation rules, or even language, than users in South America or Africa.  
To manage these differences Business Units can be created and configured, and users will be assigned 
to them. 

Business Units can be used to:  

• control Data Sharing access (checking out data) 

• set up a common Upload location for data in hyperlink fields 

• configure a notification or automatic transfer of 'master' data when closing DHLogger, Sample 
Station or MineMapper 3D 

• limit access to projects and the holes/data within 

• control codes in Reference Lists 

• configure context-sensitive Reference Lists 

• limit the visibility of columns in the Samples screen 

• customize System Preferences 

• customize the validation and interface of data entry forms 

• configure the visible columns in custom Reference Lists 
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LOGGING STYLES  There may be differences in the data logging of different groups of users, like an 
Exploration Group or a Grade Control group.  The concept of a Logging Style is available to customize a 
user's view of certain tables (or even columns). 

Logging Styles can be used to:  

• control access to tabs tables, and customize visibility to the column level 

• restrict sample types 

• setup Process Flow authorization 

• apply Sample Naming templates 

• control Depth Adjustment templates 

 

ASSAY STATUS CODES  When samples are entered into the database, they are given an initial status.  
Administrators can identify what that status is by default per user.  Most often, the initial value set for 
all users is 'LOGGED', and after results are returned by import, the status will be updated as 
appropriate  (COMPLETE, PASSED, FAILED) and the value may again be updated when a person 
performs Batch Authorization operations (AUTHORIZED, FAILED -QP ACCEPTED). 

 

PROFILES  At a very basic level, permissions to various activities in the application are handled using 
profiles. To begin with, users are typically assigned either ADMINISTRATOR or FIELD GEOLOGIST profiles, 
which covers most of the general permissions in the application.  As users need access to specific 
activities, additional profiles can be assigned.  For example, access to the Batch Authorization functions 
require the QUALIFIED PERSON profile; and access to perform Authorization of Drill Holes or Surface 
Samples requires the CERTIFIED PERSON profile. 

 

CREATING A USER 

Creating users is performed in the User 
Administration module, accessible from this tile, or 
[Options > System Administration > User 
Administration...] menu. 

To perform some actions in this window will require 
the SQL Server securityadmin role.  If the currently 
logged in user does not have it, a prompt to enter 
the User and Password of a user who does have the role will appear. 



 

3/31/2023 Fusion Administrator 20 
 

 

 

Clicking on the New toolbar item will open up the maintenance window to create a New 
User. 
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If there are users that have not been synchronized with the database, they will be 
displayed with grey user icons in the 'user tree'.  These users can become synchronized by 
selecting the user and using the 'Sync  DB' menu option. 

 

Notes:  

• If the login exists in SQL Server, you will be prompted to replace the user definition with the 
one you have just edited. 

• If there is a Fusion Remote data source configured, you will be prompted to configure the user 
and login in that database, in that instance of SQL Server. 

This module will also be the location to assign Business Units, Logging Styles, Assay Status Codes, and 
Profiles to the user by dragging-and-dropping from the lists on the right to the 'user tree' on the left. 

When leaving this module, you will be warned if there are users that have not yet been assigned to a 
Business Unit or a Logging Style, and you will be given a chance to correct it if you want.   

•Logon Type: Database Authentication or Windows Authentication

•Domain Name: Only available if Windows Authentication is selected

•User ID: User's login name. It can contain letters, numbers, dashes, underscores, 
spaces, periods, #, @ and $

•Password: User's password

•Working Role: The working role handles much of the physical database permissions, 
like UPDATE or DELETE access on a table.  This is usually Role_Century_Admin for 
administrators, and Role_Field_Geologist for most other users

•Enforce Password Policy: Enforce the rules defined for the user's password

•Minimum Password Length: Enforce a specific length for the user's password

•Password Expires: Enforce the validation of the age of the users password.  This 
checkbox will only be used for database authenticated users or in organzations that do 
not have a password policy.  If a password policy is defined for a windows 
authenticated user, it will provide the rule for the password expiry

•Expires Length (Days): The length of time in days before the password expires

•Expiry Warning Length: Control when the expiry warning will appear to users, 
defaulting to 7 days before expiration if it is not changed 

•First Name, Middle Name, Last Name: User's personal information (First and Last 
Name are mandatory)

•Cost Center, Department, Phone Number, Location: Additional, optional 
information about the user

•Email Address: Email address, will be used if user is identified as an email recipient 
when configuring  automatic email notifications

•Active:identifies the user's current status, disabling will prevent access into the 
applications

•Connect to Central: enables the user to connect with DHLogger or Sample Station  
directly against the Central database

•Sync with DB: automatically adds the Login to the SQL Server  security, and creates 
the user mapping in the database to the login

User Details
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Without a Business Unit a user will not be able to use DHLogger or Sample Station.  Without a 
DHLogger Logging Style a user will not be able to use DHLogger. 

 

The Report toolbar item will open a Report Viewer window that allows you to select a 
user and view the configuration associated with that user.  The report can be printed 
from this window also. 

 

The Admin toolbar item opens a window that allows you to choose the user that will 
be the System Administrator user.  This user must have Role_Century_Admin or 
Role_Full_Client_Admin, and they require externally-managed Server/Database roles 
of ‘securityadmin’ and ‘db_owner’. 

The typical creation/management of this user would be to have the Database Administrator create 
a SQL Server Login for this new user, granting ‘securityadmin’ and mapping the login to the Central 
database with ‘public’, ‘db_owner’ and ‘Role_Read_Only’ roles. Repeat this for the FusionRemote 
server, if applicable.  Then, create the Fusion user in the User Administration window, if it is not 
already done.   

After this process, the user can be selected as the new System Administrator user, and if desired, 
the user named ‘admin’ can be removed.  

 

CREATING A BUSINESS UNIT  

Creating business units is performed in the Business 
Units module, accessible from this tile, or [Options > 
System Administration > Business Units...] menu. 
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Clicking on the New toolbar item will open up the maintenance window to create a New 
Business Unit. 
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This module will also be the location to assign Users to Business Units, and Assay Status Codes, and 
Profiles to the user by dragging-and-dropping from the lists on the right to the 'business unit tree' on 
the left. 

Users are required to be assigned to one Business Unit but can be assigned to more than one.  Each 
user can access "User Preferences" to set their 'active' unit if they are assigned more than one.  

When leaving this module, you will be warned if there are users that have not yet been assigned to a 
Business Unit, and you will be given a chance to correct it if you want.   

Without a Business Unit, a user will not be able to use DHLogger or Sample Station. 

 

The Report toolbar item will open a Report Viewer window that allows you to select a 
Business Unit and view its associated configuration.  The report can be printed from this 
window also. 

 

 

•Business Unit, Description: name and detail for the business unit

•Allow Data Sharing: identifies whether data created by users with this Business 
Unit is shared with users in other Business Units.  (This setting is ignored unless  
the Fusion.INI file has been manually configured with "CheckForDataSharing=Y")

•File Storage Location: a folder location where files identified in custom 
hyperlink columns will be stored - Synchronization will re-point the hyperlinks 
accordingly when this location is updated

Business Unit Details

•Remind users of 'master' data in the Local Database: enable to provide a 
message to users when closing DHLogger, Sample Station or MineMapper 3D

•Prompt user to take immediate action: if disabled, user only receives message 
about 'master' data; when enabled, user can choose an action / database to 
occur immediately --> The Transfer In window will be launched with the 
supplied database connection and the specified action

•Default Action: to pre-populate in the prompt  - either Check In or Copy In, if 
left blank 'No Action' will be displayed

•Default Database: to pre-populate in the prompt - Fusion Remote or Central 
(depends on existin DSNs)

Data Notification - when closing the applications
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CREATING A LOGGING STYLE  

Creating Logging Styles is performed in the Logging 
Styles module, accessible from this tile, or [Options 
> System Administration > Logging Style...] menu. 
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Clicking on the New toolbar item will open up the maintenance window to create a New 
Logging Style. 
 

 

 

This module will be the location to assign Sample Types, associate Sample Naming templates, assign 
Tables, customize visibility of columns if 'Columns Limited by Logging Style' is enabled, show/hide Tabs 
(Collar, Details, Samples, LAS, Depth Adjustment), show/hide Blast Hole module, enable Planned 
Drillholes, and create Process Flows for partial authorization of data. 

A user may be assigned multiple logging styles, depending on their needs. Before entering data, any 
user with multiple logging styles will be prompted to select an 'active' style.  This can be changed at 
any time in the "User Preferences" window. 

When leaving this module, you will be warned if there are users that have not yet been assigned to a 
Logging Style for DHLogger, and you will be given a chance to correct it if you want.   

Without a Logging Style, a user will not be able to use DHLogger. 

 

 

 

The Report toolbar item will open a Report Viewer window that allows you to select a 
Logging Style and view its associated configuration.  The report can be printed from this 
window also. 

 

  

•Logging Style: name of logging style

•Description: description / details of logging style

Logging Style Details
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DRILL HOLES 

OVERVIEW 

Logging drill holes with DHLogger involves some common practices: recording collar information, 
capturing coordinate data, measuring survey information, and taking and assaying samples.  To enter 
the information for each of these areas, there are some default (standard) reference tables that are 
created and associated with standard columns in the data tables.  Many of the standard columns, and 
most of the tables, can be configured to be hidden if they are not required.  This section will describe 
many of the reference tables that support the recording of information in the standard tables. 

COLLAR TAB 

PROJECT  Every drill hole must belong to a Project Number. 

[Maintain > Projects…] 
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HOLE TYPE  A list of codes and descriptions defining the hole type.  Hole Type is used in configuration 
of other areas of the application (e.g. Planned Drill Holes, QC Packages).  Hole Type is a required 
column in the collar table, and a default can be set in the System Preferences window in DHLogger in 
each Local database.    

Along with the Hole Type and Description fields, Module will identify whether the type describes a drill 
hole, blast hole, or a channel sample which is created in MineMapper. 

As well, the Destination Compositor field is used to filter the data in the Destination Compositor 
module – data will be retrieved only for holes that are of a type that allows for compositing. 

A system hole type, called ‘BLAST’, exists in this list, and cannot be modified. It is used in the Blast Hole 
module. No other hole types can be created for the Blast Hole module 

[Maintain > Reference Tables > Hole Types…] 

•Project Number, Project Name: the code and description of the project.

•License Number: optional, can store the operating license giving permission to 
drill in the area covered by the project.

•Project Status: OPEN / CLOSED.  Drill holes can not be added or transferred in 
to a project that is closed.

•Unit of Measure: METRIC / IMPERIAL.  Indicates whether the hole is 
measuring in meters or feet.

•Created By, Created Date: store the origins of the project

•Hide Project: administrators can flag a project to no longer be visible in 
DHLogger's project selection dropdowns

•Comments: store additional information about the project

•Default Grid Type: pick a grid type to be used as the default in new Coordinate 
records for drill holes or surface samples added to the project

CUSTOM columns can be added to this table using the "Custom Table" module 
and choosing 'Standard', then selecting 'PROJECT' table.

Project Information

•Polygon: coordinates can be validated against a polygon (shape) file.  These 
will need to be imported [File > Imort > SHP Import] prior to selection in this 
dropdown

Coordinate Validation
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HOLE SIZE  Optional, list of the codes and descriptions that may define the drill hole’s diameter. 

[Maintain > Reference Tables > Hole Sizes…] 

 

 

HOLE LOCATION  Optional, list of location descriptions.  These locations are typically the different 
properties belonging to the drilling project.  A default can be set in the System Properties in DHLogger 
in the Local Database.   

[Maintain > Reference Tables > Hole Locations…] 
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CORE STORAGE  Optional, list of locations of where the drill core is stored.  A default can be set in the 
System Properties in DHLogger in the Local Database.   

[Maintain > Reference Tables > Core Storage…] 

 

 

CASING TYPE  Optional, list of casing types.  A default can be set in the System Properties in DHLogger 
in the Local Database.   

[Maintain > Reference Tables > Casing Types…] 
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CONTRACTOR  Optional, list of contractors used in the drilling project. 

[Maintain > Reference Tables > Contractors…] 
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PHRASES  Optional, this maintains a list of commonly used phrases that can be dragged and dropped 
when entering text in the Comment Editor on the Collar window, or in the Interval window.  

[Maintain > Reference Tables > Phrases…] 

 

 

DETAILS TAB 

The Details tab in DHLogger is comprised of the Major and Minor Lithology sticks, and several sub-tabs.  
By default, these tabs include four standard interval-related tables (Texture, Structure, Alteration, and 
Mineralization) and five standard drill hole-related tables (Location, Direction, RQD, Mag Sus, and 
Wedge).  Any or all these tabs can be hidden, and custom tabs can be created if necessary.  Custom 
tabs will be visible at the end of any standard tabs. 

To support the standard tables, several reference tables exist, which are linked to columns within the 
data tables. 

 

ROCK TYPES  A list containing the codes and descriptions that define the lithology that is found in the 
drilling project.  These codes are used when entering Major and Minor interval records. 

They appear in a ‘tree’ format, allowing codes to be grouped or nested.  All codes are created under 
the system code: ‘ROCK TYPES’. 

[Maintain > Reference Tables > Rock Types…] 
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The Rock Type Details (except for the Rock Type Code) can also be customized for each business unit by 
configuring their assigned rock codes within the Business Unit Preferences window. 

[Options > System Administration > Business Unit Preferences…] 

  

•Rock Type Code: the code that will be the main entry in the tree

•Short Description: the description that appears in parentheses in the tree

•Long Description: a longer description of the rock type

•Rock Type Bitmap: a bitmap that is associated with the code, will be displayed 
in the Lithology sticks, in some  default reports, and in the Graphic Log

•Comments: additional information to be stored about the Rock Type code

Custom columns can also be added to this reference table.

Rock Type Details

•This shows a list of the business units that can see / use this rock type code.  
You can add/delete business units with the buttons below the list.

Associated Business Units
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INTERVAL DESCRIPTORS  These lists are used in the standard interval-related tables (Texture, 
Structure, Alteration, Mineralization).  For each list, a new code can be added, along with a description 
and bitmap image. 

[Maintain > Reference Tables > Interval Descriptors…] 

 

 

 

Depending on the “Grid Conversion Method” setting in the System Preferences, some of the 
information in the following windows may or may not apply. 

 

COORDINATE TYPES  This list defines the different types of coordinates (e.g. Primary, Alternate; 
Planned, Actual, Estimate) used in the drilling project.  Along with the code and description, each entry 
will have a ranking (lowest number = highest ranked / preferred type) for the purposes of exporting 
and reporting.  This list is required for data entry into the Location tab in DHLogger and Sample Station. 

[Maintain > Reference Tables > Grid Definitions > Coordinate Types…] 
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GRID TYPES  This is used to describe all the coordinate systems that may be in use in a drilling project.  
For example, a mine grid that is oriented with the orebody might be used for planning purposes, while 
surface exploration data may be in the UTM system.  Grid Type is a required field for data entry in the 
Location tab in DHLogger and Sample Station. 

[Maintain > Reference Tables > Grid Definitions > Grid Types…] 
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When the CENTURY grid conversion method is used, new grids are entered by clicking NEW, and editing 
directly in the above list window.   

However, when CSMAP grid conversion method is used, new grids are added by clicking NEW to open 
the Coordinate Editor window: 

 

And then from this window, click NEW to enter details into another window: 

•Grid Type Code, Name: a unique code and long name for the grid

•Uses Dist: identifies whether the grid uses the Distance flag

•Comments: to record other details about the grid

•Scaling Factor: a numeric field that defines the grid's scaling

•Grid Category Code: chosen from a customizable picklist.  Only grids that are 
categorized as 'In Use' will display in lists that are used to specify a Grid Type.

•Status Code: Defined / Undefined.  A grid that is Defined can be converted to 
any other Defined grid system within Fusion Administrator. Undefined means 
that the coordinates cannot be converted since the relationship to other grids is 
unknown.

Grid Type details
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NOTE:  new grids require that the Key Name ends in a colon (:) 

 

GRID CONVERSION MAPPING  As indicated above, when working with CSMAP grid conversion 
method the “Defined”  status indicates whether grids will be able to be converted.  The conversion is 
handled with routines found in CSMap.dll.   When working with CENTURY grid conversion, conversion 
mappings must be configured for each grid. 

[Maintain > Reference Tables > Grid Definitions > Grid Conversion Mapping…] 
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The following figure illustrates the association between two grids and shows the information that will 
be used in the conversion mapping. 

 

•From Grid: the source coordinate system

•Unit of Measure: the unit of measure of the source grid

•Northing, Easting, Elevation: the coordinates of the origin of the Source grid, in 
the target's coordinate system

•To Grid: the target coordinate system

•Unit of Measure: the unit of measure of the target grid

•Northing, Easting, Elevation: the coordinates of the origin of the Target grid, in 
the source's coordinate system

•Delta Azimuth: the rotation angle between the two grids

Grid Conversion Mapping Details
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DATUMS  This editor allows for the addition or deletion of full descriptions of the Grid Datums that are 
being used in DHLogger and Sample Station. 

[Maintain > Reference Tables > Grid Definitions > Datums…] 

 

ELLIPSOIDS  This editor allows for the addition and deletion of full descriptions of the Grid Ellipsoids 
used in DHLogger and Sample Station. 

[Maintain > Reference Tables > Grid Definitions > Ellipsoids…] 

 

 

TEST TYPES  This list contains the various tests that may be used when drilling a hole, used to measure 
the azimuth and/or dip.  This is required data when entering records in the Direction tab. 



 

3/31/2023 Fusion Administrator 41 
 

[Maintain > Reference Tables > Test Types…] 

 

 

 

SAMPLES TAB 

Configuration of columns for the Samples window is discussed under the Module Configuration – 
Customize Sample Screen.  The lists that are referenced in this tab, however, are configured under the 
Reference Tables > Sample Definitions menu. 

 

 

SAMPLE TYPES  This list allows for the configuration of sample types of the various categories: Original, 
QC, Composite.  In DHLogger and Sample Station, the sample types that are available for selection will 
depend on the area of the application that you are in.  For example, you are not able to select “Original” 
sample types when creating QC Samples.  And likewise, you can only select “Composite” sample types 
when creating a sample in the Composites tab. 

[Maintain > Reference Tables > Sample Definitions > Sample Lists…] 

•Test Type, Description: a code and long description of the test

•Dip Only: identifies whether the test only measures a dip value (not azimuth)

•Calc Azimuth & Dip: indicates that the drillhole azimuth and dip are to be 
calculated in DHLogger from a set of known coordinates (e.g. collar and toe 
coordinates). Unselect it if the azimuth and dip are manually entered.

•Comments: additional information about the test

•Ranking: a ranking that is given to identify the most accurate results, used 
during exporting and reporting, where only the highest ranked results may be 
returned

Test Type Details
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•Sample Type, Description: the code and description of the sample type

•Allow Gaps: allow samples with gaps in the intervals to be entered in the 
sample table

•Allow Overlaps: allow samples with overlapping intervals to be entered in the 
sample table (once this is enabled, it cannot be disabled)

•Samples must start at Depth Zero: indicates whether the first sample has to 
have a depth_from = 0

•Sample Category:
Original - used for original (not duplicate) assay samples
QC - used for duplicate or other quality control samples
Composite - used for original (not duplicate) composite samples

Sample Type Details
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BLAST HOLES 

OVERVIEW 

Blast holes are essentially short, quickly logged drill holes which can be logged in their own module 
within DHLogger. This type of logging involves some common practices: recording Collar information 
(azimuth, dip), capturing coordinate data, a blast length, and one or two samples. As with the tables for 
drill holes in DHLogger, there are some default reference tables that are created and associated with 
standard columns in the blast hole data tables.  This section will describe many of the reference tables 
that support the recording of information in the standard tables. 

FILTER CRITERIA 

PROJECT  This list defines the project numbers used in the blast hole program.  Read the previous 
description of Projects. 

[Maintain > Projects…] 

SAMPLE TYPES  This list defines the sample types used in the blast hole program.  Read the previous 
description of Sample Types. 

[Maintain > Reference Tables > Sample Definitions > Sample Lists…] 

 

LOGGING DATA 

COORDINATE TYPES  This list defines the different types of coordinates (e.g. Primary, Alternate; 
Planned, Actual, Estimate) used in the program.  Read the previous description of Coordinate Types . 

[Maintain > Reference Tables > Grid Definitions > Coordinate Types…] 

 

GRID TYPES  This list defines the grid coordinate systems used in the program.  Read the previous 
description of Grid Types. 

[Maintain > Reference Tables > Grid Definitions > Grid Types…] 

 
CUSTOMIZABLE BLAST HOLE TABLE  The capability exists to add custom columns to the blast hole 

logging window. This is accomplished by adding columns to DHL_BLAST_HOLE.  Read the previous 

description of adding columns in the Customizing a Data Table section. 

[Maintain > Define Custom Table...]   
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SURFACE SAMPLES 

OVERVIEW 

Logging surface samples with Sample Station involves some common practices: recording location 
information, capturing coordinate data, and assaying.  As with the tables in DHLogger, there are some 
default reference tables that are created and associated with standard columns in the data tables.  This 
section will describe many of the reference tables that support the recording of information in the 
standard tables. 

SELECTION CRITERIA 

COORDINATE TYPES  This list defines the different types of coordinates (e.g. Primary, Alternate; 
Planned, Actual, Estimate) used in the sampling project.  Read the previous description of Coordinate 
Types . 

[Maintain > Reference Tables > Grid Definitions > Coordinate Types…] 

 

GRID TYPES  This list defines the grid coordinate systems used in the sampling project.  Read the 
previous description of Grid Types. 

[Maintain > Reference Tables > Grid Definitions > Grid Types…] 

 

SAMPLE TYPES  This list defines the sample types used in the sampling project.  Read the previous 
description of Sample Types. 

[Maintain > Reference Tables > Sample Definitions > Sample Lists…] 

 

REGION CODES  This list defines the region codes that are used in the Location Code configuration.  It 
is required and represents a categorization above Project.  

[Maintain > Reference Tables > Sample Definitions > Region Codes…] 
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LOCATION CODES  This is a configurable, hierarchical structure of locations, to which all surface 
samples belong.  All locations consist of a Region and a Project (these are mandatory), however 
administrators can add any number of levels below these. 

[Maintain > Reference Tables > Location Codes…] 

 

This screen shows the addition of a new level (AREA) below the PROJECT level: 

 

▪ set Header = Yes to create a new level 
▪ If the header has Required = Yes, then any headers above in the hierarchy will also be set to 

“required”. 
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Once new levels (Headers) are created, you will then be able to add new codes:  

 

 

This screen shows the Location Codes tree once some codes have been added to the “Area” level under 
the “NEW > 2005” Region/Project: 

 

 

MEDIUM TYPES  This list defines the various physical mediums of the surface samples being logged. 

[Maintain > Reference Tables > Sample Definitions > Medium Types…] 
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LOCATION/COORDINATES 

COORDINATE TYPES  This list defines the different types of coordinates (e.g. Primary, Alternate; 
Planned, Actual, Estimate) used in the sampling project.  Read the previous description of Coordinate 
Types . 

[Maintain > Reference Tables > Grid Definitions > Coordinate Types…] 

 

GRID TYPES  This list defines the grid coordinate systems used in the sampling project.  Read the 
previous description of Grid Types. 

[Maintain > Reference Tables > Grid Definitions > Grid Types…] 
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MODULE CONFIGURATION 

OVERVIEW 

There are many modules available in DHLogger and Sample Station that require configuration to be 
completed in Fusion Administrator. This section will provide information on several of these modules. 

CUSTOMIZE SAMPLE SCREEN 
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The folders in the left pane represent the Sample Screens that may be customized. Expand the tree to 
view the columns already associated with each module. 

 

Sample Screen Description 

Drill Hole, Blast Hole and Channel 
Samples 

Drill Hole samples are accessed from the Samples tab on the 
Drill Hole window in DHLogger.   
Blast Hole samples are accessed from the Blast Hole module in 
DHLogger. 
Channel samples are accessed in MineMapper 3D (Channel 
Sample wizards). 

Drill Hole Composite Samples Drill Hole composite samples are accessed from the Composite 
Samples tab on the Drill Hole window in DHLogger. 

Surface and Point Samples Surface samples are accessed from the Results tab in Sample 
Station.  Point samples are accessed in MineMapper 3D (Point 
Sample wizards). 

Surface Sample Header This screen is accessed from the Surface Sample Header 
window in Sample Station. 

Surface Sample Real Time Results This screen is accessed from the Real Time Results tab in Sample 
Station. 

Modular Samples Modular Samples are visible as a child tab in the Standalone 
Tables module when the Group has been configured to use 
samples. 
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When creating a new column for any of these sample screens, you are required to select a Column 
Type.  The available options may include: Results Column, Storage Column, and /or Composite Result 
Column (for composite samples only). 

 

RESULT COLUMNS  These columns are used for storing analytical results which typically have their 
values imported via Lab Assays Import.  These columns can be either CHARACTER or NUMERIC columns.  

Most often, Result Columns are numeric columns that are created using 3 standard picklists: 
element_type, assay_unit_of_measure, and analytical_methods.  They will be combined with 
underscores.  For example, "Au", "gpt", "FA" would become "Au_gpt_FA". 

So, prior to creating columns, these reference lists need to be populated with values to be used. 

[Maintain > Reference Tables > Sample Definitions > Sample Lists...] 
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Result column window – Numeric data type 

 

 
Result column window – Character data type  
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•Column Name: CHARACTER column property only, the physical name of the 
column

•Element Type: NUMERIC column property only, the element that is represented by 
this column, from values defined in the 'Element_Type' reference list

•Unit of Measure: NUMERIC column property only, the unit of measure that is used 
for the values in this column, from values defined in the 'Assay_Unit_of_Measure' 
reference list

•Analytical Method: NUMERIC column property only, the laboratory testing 
method used to obtain the results, from values defined in the 'Analytical_Methods' 
reference list

•Column Title: label that will be used in the sample screen , by default numeric 
column titles will be element_unitofmeasure_method (eg. Au_gpt_FA), while 
character column titles will be column_name ***

•Default Technique: NUMERIC column property only, optional, the default 
laboratory testing method that is listed for the column. This is infrequently 
referenced, but may be used in the Advanced Query in the Samples tab

•Data Type: for result columns, this field is limited to NUMERIC and CHARACTER

•Total Width, Precision: indicates the maximum total digits and number of 
decimals  (eg. 12, 4 --> 12 total digits, with 8 before the decimal and 4 after)

•Decimal Places to Show: allows for customization of the column's display format

•Is Editable: indicates if the value stored in this column is read-only or can be 
changed through the interface.  Result columns are typically not editable, as they 
are populated through a Lab Import.

*** Business Unit preferences may override these settings

Column Information

•Calculation Formula: if a calculated column is needed, simply type or drag/drop 
operatons, functions and columns into this field; validation of the formula occurs 
before saving, checking for correct syntax; do not use another calculated column in 
a formula

Calculation Information
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STORAGE COLUMNS These columns are general columns, and can be added to any of the modules, 
like custom columns in custom tables. 
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•Column Name: physical name of the column in the table

•Column Title: custom label for the column ***

•Data Type,Total Width, Precision: column's definition details

•Column Style: Edit / Dropdown with FK  (picklist)

•Lookup Table, Data Column, Display Column, Lookup Style: picklist settings 
available when you have selected "Dropdown with FK" style ***

•Edit Style: (none) / checkbox style; DateTime / Time Only - 24 Hour / Time Only 
- am-pm

•Default Value, Min Value, Max Value: default value for the column, and for 
numeric columns, Minimum and Maximum values used in validation during data 
entry ***

•Inherit Values: if enabled,  when creating a new row the columnis pre-
populated with the previous row's value

•Is Editable: indicates if the value is read-only or editable

•In Average Table: when enabled, the column is also created in the related 
AVERAGES table

•Context-Sensitive: setting, available when you have selected "Dropdown with 
FK" style; would indicate that the values in this column's picklist are dependent 
on the value entered in another column that has a picklist; within the 
configuration, the column that provides context can vary by Business Unit

*** Business Unit preferences may override these settings

Column Information

•Calculation Formula: if a calculated column is needed, simply type or drag/drop 
operatons, functions and columns into this field; validation of the formula 
occurs before saving, checking for correct syntax; do not use another calculated 
column in a formula

Calculation Information
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COMPOSITE RESULT COLUMNS  These columns are only available in the Drill Hole Composite 
Samples module.  They are used for creating a calculated average column. 

 

 

 
  

•Column Name: physical name of the column in the table

•Column Title: custom label for the column ***

•Assay Sample Column for calculating the average: the Drill Hole Sample column 
that contains the values that are averaged

•Average Type: Regular / Weighted by Sample Interval / Weighted by Column 

•Column for calculating the weight: enabled when Average Type = "Weighted by 
Column"

Column Information
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LABORATORY ADMINISTRATION 

The Laboratory Administration window allows users to configure Laboratories, Lab Packages and 
Laboratory Analytical Details.  The Lab Package and Laboratory Analytical Details configuration is used 
by the Lab Import module to identify how results are imported / validated. 
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To add a new Laboratory, simply select the ‘Laboratories’ branch of the tree and click the 
New button. 

To edit a Laboratory, double-click on the existing lab. 

 

 

 

 

•Laboratory: A unique name for the lab.

•Address, City, Province/State, Postal/Zip Code, Country: Address details for the 
lab.

•Phone Number, Fax Number: Phone/Fax details for the lab.

•Email Address: An email address for a contact at the lab.

•Comments: Additional information concerning the lab.

Laboratory
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To add a new Lab Package, simply select the ‘Lab Packages’ branch of the tree and click 
the New button. 

To edit a Lab Package, double-click on the existing package. 
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•Laboratory: The name of the lab to which the package will be assigned.

•Lab Package: The name of the package.

•Start Date, End Date: The date range that this package is active.

•Cost: The price the lab is charging for this package's analysis.

•Element Identifier: Indicates whether the lab imort file will contain a single item 
(element) or the element, unit of measure and analytical method as the means to 
identify each result.

•Analysis Type, Preparation Method: Fields linked to customizable lists that can help 
define the analysis options of the lab package  (eg. Routine analysis, using a Dry Weight 
preparation method)

To manage these lists go to [Maintain > Reference Tables > Laboratory Administration > 
Lab Package Analysis Types...] 
and [Maintain > Reference Tables > Laboratory Administration > Lab Package 
Preparation Methods...]

•Hole Type / Medium Code: The package can be associated with multiple hole types or 
surface sample medium codes, and these fields can be used to assist with filtering 
and/or validation in the Sample Dispatch

•Lab Import Logic: Occurence Number Logic / Sample Type Mapping.  Defines how the 
lab import assigns sample types to unknown samples (Lab Duplicates or Lab QAQC)

•Comments: Additional information about the Lab Package.

Package Details

•Occurrence Number Logic: assigns sample types based on sequential ordering of the 
sample numbers contained within one lab file

Occurrence Number: provide the occurrence of the sample
Sample Type: from a pick list , select the sample type that the occurrence represents 
(ex.  2nd occurrence of sample A  = PulpRep, 3rd occurrence = PulpRep2)
Note: if you enter an occurrence = 1, results will only be updated in the 
DHL_SAMPLE_COLUMN_DETAILS, not in the actual sample table

•Sample Type Mapping: assigns sample types based on a sample type code assigned to 
the sample numbers contained within one lab file 

Lab Type: the name of a sample type given by the lab
Sample Type: the name of the corresponding sample type in DHLogger/Sample Station
Action: Use / Ignore.  Identifies if the import ignores the sample type assigned by the lab 
and assigns the sample type defined in DHLogger / Sample Station.
When "Action = Use", results will only be stored in DHL_SAMPLE_COLUMN_DETAILS; 
when "Action = Ignore", results will be updated in the appropriate sample table
Map to Original: Y/N. Indicates if the import validates the result based on the sample 
type or as a lab duplicate
Description: a long description of the lab import logic

Lab Import Logic
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To add a new Lab Package Detail, simply select the ‘Lab Package Details’ branch of the 
tree and click the New button.   

To edit a Lab Package Detail, double-click on the existing package detail. 
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•Column Type: Initial identification of the type of column - Numeric (Assay) or 
Text

•Element Type: The element that was tested for in the sample.

•Unit of Measure: The unit of measure that the results are expressed in.

•Analytical Method: The analytical method that the lab will be using.

•Column Name: TEXT column only, identifies the column

•Minimum Detectable Limit, Maximum Detectable Limit: The detection limits of 
the specific analytical method for this element/unit of measure

•Validate Detection Limits: Indicate whether or not detectable limits will be 
validated during the import of results

•Required for Complete Import: Indicates whether or not a result for this 
element must be present in the import file.  If a result is not returned, the 
imported sample is tagged as Partial

•Element in Import File: The label used in the import file to identify the element 
being analyzed (ex. Au, Ag, Cu_ppm)

•Unit of Measure in Import:The label used in the import file to identify the unit 
of measure of the result.  This column is only applicable if the 'Element 
Identifier' option for the Lab Package is unchecked.

•Analytical Method in Import File: The label used in the import file to identify 
the  method used to analyze the result.  This column is only applicable if the 
'Element Identifier' option for the Lab Package is unchecked.

•Mapped Drillhole Assay Column: Identifies the column in 
HOLE_ASSAY_SAMPLE into which these results will be imported

•Mapped Surface Sample Column: Identifies the column in 
SSTN_SURFACE_SAMPLES into which these results will be imported

•Mapped Drillhole Composite Column: Identifies the column in 
HOLE_COMPOSITE_SAMPLE into which these results will be imported

•Mapped Modular Sample Column: Identifies the column in 
MODULAR_SAMPLES into which these results will be imported

•Comments: Additional information for the Lab Package Detail

Lab Package Details
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There are several lists that can be configured to support the Laboratory Administration module. The 
Laboratories and Packages menu opens the same Laboratory Administration window that is opened 
from the tile. 

 

CUSTOM LAB IMPORT TEMPLATES  This window allows users to customize and specify the format of a 
laboratory file so that the data can be read by the Lab Import module.  The format of the lab import file 
must be a CSV (comma-delimited) File.  This file type allows users to specify the row and column of the 
different data sections. 

[Maintain > Reference Tables > Laboratory Administration > Custom Lab Import Templates…] 
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•Name, Description: A name and description to identify the import template.

Template

•Name, Package: Identifies the lab and lab package associated with this 
template.  
These can be omitted if they are specified by position.

Laboratory

•Specify the Row and Column locations for the Header Information:
Laboratory, Lab Package: Not required if this information is specified in the 
Laboratory section.
Lab Reference Number, Element List: Required information
Sample Dispatch, Analysis Date, Unit of Measure, Analytical Methods:
Optional information

Location of Header Information

•Specify the Row and Column location for the Result information:
Sample Numbers: specify the location of the first sample number in the import 
file.  The row specified here will be the same row for each of the following 
pieces of information - any sample results found above this row will not be 
imported; only sample results will be found in and after this row.
Element Results: the first column location of the analytical results in the import 
file.
Sample Type Logic: column location of sample type logic, only necessary if the 
Lab Package uses Sample Type Mapping.
Date Shipped, Date Received: optional information
Standard Validation Run 1, Standard Validation Run 2: the location of the 
columns defining the run numbers, only necessary if the file contains standards 
that use run validation.

Fields only applicable when Sample Fractions are enabled
Column for Calculated Global Sample: Weighted Average of Size Fractions: the 
location of the weights of the Sample Fraction samples
Size Fraction Name: location of the Screen Size Name of the size fraction 
sample, used for lookup of the actual sample number
Density Fraction Name: location of the Relative Density Name of the density 
fraction sample, used for lookup of the actual sample number

Location of Results

•Select and Open a file that this template is going to match.

•Drag and drop the field locations from the file to the template definition for 
easy entry of row/column positions.

Lab File Preview
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LAB PACKAGE ANALYSIS TYPES  This list contains possible analysis types that can be associated with a 
Lab Package 

[Maintain > Reference Tables > Laboratory Administration > Lab Package Analysis Types…] 

 

 

 

LAB PACKAGE PREPARATION METHODS  This list contains possible preparation methods that can be 
associated with a Lab Package 

[Maintain > Reference Tables > Laboratory Administration > Lab Package Preparation Methods…] 
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SYSTEM PREFERENCES 

 

 

While this is not a specific module, it contains configuration settings for many other modules in the 
applications. 



 

3/31/2023 Fusion Administrator 68 
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•Enable the Selective Transfer of Tables: this feature allows users to Check Out only the 
tables they specify, instead of an entire drill hole, allowing multiple users to add data to the 
same drill hole

•Detect Duplicate Coordinates on Check In: this feature will validate the coordinates during 
a Check In of a Drill Hole, Surface Sample or the transfer of Planned Drillholes, searching for 
duplicate coordinates in the destination database. Users will have the opportunity to 
continue or cancel the transfer or Check In when duplicates are reported

•Transfer Related Sample Dispatch on Check/Copy Out: this feature will copy out the 
Dispatch Header and Dispatch Sample records for all sample dispatches that are referenced 
by the drill hole's samples or surface samples that they have been selected for Check Out or 
Copy Out

•Prompt to transfer Core Photos: this feature will prompt users after the transfer of drill 
holes to transfer any core photos associated with the selected holes from the source's 
Storage Location to the destination's Storage Location

Transfer Settings

•Access Limited by Business Unit: this will limit the access to a project's data depending on 
the user's active business unit. This setting is used in many of the applications, including 
DHLogger, Sample Station and Report Manager.
To assign projects to business units open Business Units module, and Projects will be a list 
on the right that can be dragged/dropped to the Unit tree

•Hide Closed Projects: when enabled, projects that have had their status changed to CLOSED 
will not be visible in picklist (eg. drill hole selection, surface sample selection)

Project Settings

•Reference Codes Limited by Business Unit: limit the visibility of codes in the reference 
tables depending on the user's active business unit
To assign codes to business units go to [Options > System Administration > Reference Codes 
to Business Units...]

Reference List Settings

•Preview Sample Type: when enabled, a window will be displayed that shows the sample 
type (and standard code) of each sample being imported

•Detailed Email Body: when enabled, the body of the automatic email sent following the Lab 
Import will contain a summary of the imported samples

•Allow Results to be Overwritten (LIMSAPI setting): a setting applicable to LIMSAPI only, 
that will allow analytical results to be updated (overwritten) during import with LIMSAPI 

•Check Dispatch: with this enabled, validations of the Dispatch Number will occur in Lab 
Import (eg. correct status, samples belong, missing sample)

•Update Sample Dispatch Copies: if enabled, sample dispatch information will be updated in 
'copies' of the sample dispatch records when importing  into a database other than the 
Central, and records will be flagged to update the Central when synchronization is run 
against the Central database

•Allow Modification of Lab Import Symbols in Local\Remote: enabled by default, when 
disabled a user will not be able to Add, Edit or Delete records in the Symbol Mapping table 
which is accessed through the Lab Import module

•Warn / Stop Import if Analysis Date > Import Date: set to 'Log Issue and Continue' by 
default, additional options are to 'Stop the Import' or 'Prompt to Continue'. A check of the 
Analysis Date will inform you if it is set to a future date (greater than the day you are 
importing the file)

Lab Import Defaults
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•Allow Import of Analytical Results: allows for the import of data into 'result' columns with this 
module, instead of using the Lab Import (typically used for historical data when certificates are not 
available to be imported)

•Allow Import of Reference Codes Out of Context: option to allow data to be imported when the 
data does not meet 'context-sensitive' rules.  User will be given a report and will be prompted to 
continue with the import.

Drill Hole Import Defaults

•Inherit Interval Depths for Custom Tables: automatically fills in depths to Major/Minor depths 
when entering new rows to interval-related custom tables

•Warn when entering Samples that cross Lithology boundaries: enabling this feature prompts users 
when they enter a Sample record with depths that span 2 or more Major intervals

•Validate Maximum Depth: if checked, the Maximum Depth field is enabled in the Collar screen, 
user will be prevented from saving data with depths that exceed the value that is entered in the 
Collar window

•Save data that exceeds maximum depths: enabled when "Validate" setting is checked, if checked, 
you receive prompt to save despite validation warning (will update maximum depth to current)

•Prompt when QC samples are automatically created: a prompt is presented to the user when a QC 
sample is automatically inserted into the database, informing user of the sample number and 
sample type of the added QC

•Columns Limited by Logging Style: allows customization of tables by Logging Style to extend to the 
column level.  To customize open Logging Styles module and double-click on the desired table 
found under the logging style's Tabs folder

•Enable Size Fractions: allows for the creation of 'samples' that are composed of material with 
similar particle/grain size.  Analysis is performed on these sub-samples. Usage will require 
configuration [Maintain > Reference Tables >  Sample Fraction Definitions...]

•Enable Density Fractions: allows for the creation of 'samples' that are composed of material with 
similar densities. Analysis is performed on these sub-samples.  Usage will require configuration 
[Maintain > Reference Tables >  Sample Fraction Definitions...]

•Allow Table Linking: when enabled, when inserting, editing or deleting data in one table in 
DHLogger can cause rows in dependant tables to have depth-data synchronized automatically or 
through a manual process.  Usage will require confguration [Maintain > Reference Tables > Sample 
Definition > Table Linking Configuration...]

•Prompt to re-assign QC Sample / Standard sample numbers: when enabled, geologists will have 
the opportunity to  'insert' QC Samples or Standards into a sequenced set of sample numbers, 
being prompted to automatically adjust sample numbers to maintain the ordered sequence

•Core Photo Import Depth Defaults: determines whether photos are associated with depths of zero 
(for From and To), or whether they remain empty

•Delete Photo files when deleting records from Drill Hole: determines whether the photo image 
itself, which may be found in the Storage Location, is removed from the computer when you delete 
the record from the database

•OC Desurvey: Beta Angle Measurement / Orientation Mark: settings used that determine 
calculation methods for Oriented Core Calculations 

•Desurvey: Positive Dip Upward / Survey Records / Grid / End Points: settings used during the 
Desurvey calculations in DHLogger

•Sample Station Standards: Require Project Number: Makes the Project Number column a required 
field when adding Sample Station standards. 

Data Table Settings
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•Enable Validation Rules: When this setting is enabled, any validation rules defined for the module 
and group will be run

•Only authorize Holes/Samples without validation issues: When enabled, this setting prevents the 
authorization or holes or samples that don't pass validation rules

Validation Rules Settings

•Automatically generate sample using specified length: with this feature enabled, a sample will be 
created at the same time as the blast hole using the length specified in the Blast Length column

•Multiple Samples Logged per Blast Hole: this setting will determine if more than one sample is 
allowed to be logged for each blast hole

Blast Hole Settings

•Automatically check for newer copies of Drill Holes: when this feature is enabled, when DHLogger is 
started, the application will check to see if a newer version of any drill hole copies exist in the Central 
Database (if available) and provides a report to the user

•Automatically check for newer copies of Surface Samples: when this feature is enabled, when 
Sample Station is started, the application will check to see if a newer version of any surface sample 
copies exist in the Central Database (if available) and provides a report to the user

Drill Hole and Surface Sample Updates

•Enable Dispatch Naming Template: when enabled, a user-defined template will be applied to the 
dispatch number of a newly created dispatch
To configure the template: [Maintain > Reference Tables > Sample Definitions > Sample Dispatch 
Naming Templates...]

•Use Filters to Restrict Lab Package Selection: enabling this setting adds two fields (Analysis Type, 
Hole/Medium) to the Sample Dispatch Header section in a dispatch that will filter the list of lab 
packages

•Use Lab Package to Filter Available Samples: this setting will filter the list of available samples to 
holes that have the same Hole Type or surface samples that have the same Medium Code as what is 
associated with the selected lab package

•Use Lab Package to Validate Selected Samples: this setting will validate the dispatch's selected 
samples allowing only samples that belong to holes that have the same Hole Type or surface samples 
that have the same Medium Code as what is associated with the selected lab package

•Warn if Sample has already been dispatched: enabling this setting will add validation when selecting 
samples to include in a dispatch - prompting you when you have chosen a sample that is already 
included in another dispatch that exists in your database

•Lock Samples in Data Tables once they are dispatched: when this setting is enabled, samples that 
belong to a Sent Dispatch will no longer be available for editing (depths, sample number) or 
deletions, unless the user has the "QUALIFIED PERSON" profile assigned; enabling this feature will 
change the system's workfow, allowing only for a dispatch to be created and sent from the Local 
database, and only 'master' (ie. new/checkedout) samples can be added to a dispatch

•Limit Number of Samples: this setting will notify a user when a maximum number of samples have 
been added to a dispatch

•Include Sample Fractions in Sample Limit: Identifies if sample fractions are counted when 
determining if the sample number limit has been reached

•Warn or Restrict When Sample Limit Reached: Defines whether the user receives a Warning 
message when the Sample Number Limit (previous setting) has been reached, or whether they will be 
prevented from adding any more samples to the dispatch

•Update Sample Type in Dispatch: this setting will confirm/update the sample types of samples in 
Dispatch of samples being transferred on Check In 

Sample Dispatch Settings
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SAMPLE DISPATCH 

There are several lists that can be configured for Sample Dispatch, a module used to group samples 
together to send to the lab for analysis. 

 

 

  

•Conversion Method: indicates the default survey grid conversion method that will be 
used when converting coordinates between two different Grid Types: CSMAP and 
CENTURY.  When using the 'CENTURY' method, configuration of conversion mappings 
will be in [Maintain > Reference Tables > Grid Definitions > Grid Conversion 
Mapping...]

•Common Grid, Second Common Grid, Third Common Grid: the default Primary, 
Secondary and Tertiary grid type (ie. LAT/LONG, UTM) used for coordinates, from 
values defined in 'Grid_Type' reference list [Maintain > Reference Tables > Grid 
Definitions > Grid Types...]

Grid Settings
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COMMON COMPANY DETAILS  This list contains contact information for companies that the 
organization may deal with.  Sample Dispatch uses the items associated with the "Carrier" company 
category in a picklist. 

 

 

COARSE REJECT INSTRUCTIONS  This is used to list the possible actions that may be performed on 
sample material that exceeds the maximum size required for assaying.  For example, you may need to 
screen a sample to remove all material that is larger than 10mm in diameter.  These instructions tell 
the laboratory what is to be done with this oversized material. 
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PULP INSTRUCTIONS  This is used to list the possible actions that may be performed on sample 
material that is smaller than the minimum size required for assaying.  For example, a sample may be 
screened to remove all material that is smaller than 2mm in diameter. These instructions tell the 
laboratory what is to be done with this undersized material, or pulp. 

 

 

SAMPLE PRIORITY CODES  This list contains the possible priorities that may be assigned to samples in 
a sample dispatch. 
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DISPATCH SAMPLE GROUPS  The configuration performed here will set up categories that may be 
used to group samples in the Sample Dispatch.  The ability exists to create a group category that will be 
linked to a reference table (custom or standard), or a category that will be editable, allowing for users 
to create the group value at the time of Sample Dispatch. 

 

 

SAMPLE DISPATCH NAMING TEMPLATES  Configuration in this window will allow for the use of a 
standard naming convention for Sample Dispatch records, based on the information supplied in the 
dispatch header. 
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EMAIL ADMINISTRATION 

This module is used to configure the automatic Email notifications for specific tasks.  The areas for 
notification are static, but whether they are enabled is configurable.  For example, it can be configured 
to send logs and charts following a Lab Import. 
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•Email Configuration: Outlook / SMTP

The remainder of the settings apply only when SMTP has been selected

•Sender Email Address, Email Password: the Login credentials used by your mail 
provider (perhaps an organization will set up one SMTP email/password that will 
be used for all Fusion Notifications)

•SMTP Host Server: The address of the Mail Server to use

•SMTP Port (default = 25): Mail port used by the mail server

•SSL Required: Enable SSL protocol if your mail provider allows / requires

***All of these settings (including Configuration) may be overridden by Business 
Unit Preferences or individual User Preferences

System Email Settings

•Notification Type Code, Description: The areas of the application where email 
notification can be enabled

•Enable Email: Y/N to enable the notification

Notification Types

•User: The recipient list, by Notification Type

•Email Address: The email address of the user, as defined in User Administration

Notified Email Recipients
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QAQC 

Since sampling is the most important part of exploration, it is important to verify the quality and assure 
the accuracy of results obtained from those samples. The definition of controls like Blanks, Standards is 
managed in the Sample Standards module and the insertion of these controls at regular intervals is 
managed in the QC Packages module. 
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SAMPLE STANDARDS This module contains the definitions for control samples that are used to check 
the accuracy of laboratory results.  Additionally, validation rules can be created for standard results 
which will be applied during Lab Import. 
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•Standard Code: A unique code or assigned to the Sample Standard.

•Standard Name: Long or descriptive name of the standard.

•Lab Control: Identifies the sample as a Lab Control.  
A Lab Control will not be available to users for selection within DHLogger, 
Sample Station or MineMapper 3D.  It is a sample that has been internally 
prepared by a lab for use in its own QC procedures.

•Blank Control: Identifies the sample as a Blank Control.
A Blank is a control sample that has a known grade of zero. They are used to 
quantify any background contamination effects in a laboratory. 

•Sterile Control: Identifies the sample as a Sterile Control.

•Comments: General comments regarding the Standard.

•Method for Determining Failures: Sets the method that is used to check 
whether or not the measured results are acceptable.
Standard Deviation: use if the result must be within a specified number of 
standard deviations from the true value to pass
Minimum, Maximum: use if the result must fall within a specied minimum and 
maximum value to pass

Standard Definition
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Each Standard contains one or more Default Results. 

 

 
  

•Element: The element being analyzed, from values defined in 'Element_Types' 
reference list

•Unit of Measure: The unit of measure that this result is reported in, from values 
defined in 'Assay_Unit_of_Measure' reference list

•Analytical Method: The laboratory method that was used to obtain the control 
results, from values defined in 'Analytical_Methods' reference list

•Mean/Actual: The value of result itself.  Itis either the exact value of a single 
test (actual) or the average of many (mean)

•Minimum Value: The lowest acceptable value for the standard to pass

•Maximum Value: The highest acceptable value for the standard to pass

•Standard Deviation: The value of one (1) standard deviation for this result. It is 
determined by running statistal analyses on a group of identical tests performed 
on the same sample.

•Deviations for Failure: The difference between the samples' actual and tested 
values must be less than the number of deviations specified here to pass.

•Deviations to Display: Specifies how many sets of lines representing standard 
deviation is drawn on the charts.

The fields that may be edited are dependent on the "method for determining 
failure" that is defined for the Sample Standard.

Assay Standard Element
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By default, batches of samples (from a lab import) are assigned a pass/fail status based on the 
performance of all defined standard results within the batch. All elements are validated against the 
defined limits, and if any values fall outside of the acceptable limits, all samples within the batch are 
considered failed. A validation rule can be used to refine how samples are validated for each defined 
result. 

 

 

•Displays the standard code and element detail for which the Validation Rule is 
being defined

Standard Detail

•Rule Type: picklist - Information or Validation - identifying whether or not 
standards and samples will be passed or failed based on the pass/fail status of 
this standard result

•Validation Type: picklist - Plus / Minus,  Run, or Std Dev Grade Range -
identifying how the samples that are validated by the rule are determined

•Validated Samples: for Plus / Minus rules, enter the number of samples above 
and below the standard's position in the file that will be validated by this rule;  
for Run rules, pick either Run Number 1 or Run Number 2 to indicate that 
samples with the same value in the Run Number column selected as the 
standard will be validated as a group; 
for Std Dev Grade Range rules, pick a Run Number if desired, to limit the 
validation of samples to those in the same run as the standard's run

Rule Details
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QC PACKAGES  This module will allow for the creation of a procedure that defines the automatic 
insertion of Quality Control samples (Standards, Blanks, Duplicates, etc.). 
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Once QC Packages are created, they are ready for use.  Each Hole Type, within each project, can be 
assigned its own QC Package.  There can be one or more assigned, but only one can be set active by 
double-clicking on the package you want to activate. 

In DHLogger, when you manually add, or auto-generate samples, the QC Package will be checked, and 
QC samples will be inserted automatically.  A running count of samples by type/hole/project is being 
stored to determine when the "frequency" number has been met to perform the insertion. 

 

 

•Sample Type: the sample type that will trigger the automatic insertion, from 
values defined in the 'Sample_Types' reference table

•Control Type: Block / Sample / Standard  - the type of control being inserted 

•Control Name: list of either Sample Types (QC category) or Standard Codes; 
depends on control type

•Frequency: how often to insert (ie. after every 10 Assay samples)

•Insertion Order: 1, or if more than one control is set to insert at the same 
frequency, indicate the order

*** If "Block" control type is chosen, another window is available to define the 
group of samples/controls that will be inserted at one time

QC Package Details
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SAMPLE FRACTION DEFINITIONS 

Sub-samples can be created and stored in the DHLogger/Sample Station system.  They are created as 
either Size Fractions or Density Fractions and are generated based on a chosen Analytical Flow and 
Preparation/Density Package.  The configuration of this module is found under the [Maintain > 
Reference Tables > Sample Fraction Definitions…] menu, which is only available once the associated 
System Preferences have been enabled ("Enable Size Fractions", "Enable Density Fractions"). 

 

 

SIZE FRACTIONS  The subsample is extracted from the original sample during the sample preparation 
process by grain-size classification / screening.  The number of subsamples depends on the analytical 
flow which specifies the number and the limits of screening intervals.  One original sample can be split 
into many size fraction samples, and they are related to the original sample (which becomes the parent 
sample). 

The configuration required for usage of size fractions includes: Preparation Packages, Analytical Flows, 
View Manager. 
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•Preparation Package: The unique name of the package.

•Screen Units: The measurement of the screen openings, from values defined in 
the 'Assay_Unit_of_Measure' reference table.

•Global Analysis Only: Indicates that there will not be any screens defined for 
the package.  There will not be any separation of the sample into sub-samples.

•Comments: Provide any extra information / description of the package as 
necessary.

Preparation Package
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Once a Preparation Package has been created, screens cannot be deleted, but additional screens can 
be added. 

If a Preparation Package was defined with "Global Analysis Only" checked, screen details are not 
allowed to be added. 

•Screen Size Name: The name of the screen, unique within this package.

•Minimum Size: The minimum size of particle the screen will catch.

•Maximum Size: The maximum size of particle the screen will catch.

•Method: The method of screening, from values defined in the 
'Analytical_Methods' reference table

•Measure: The measurement of the screen openings, from values defined in the 
'Assay_Unit_of_Measure' reference table

•Comments: Provide any extra information / description of the screen as 
necessary.

Preparation Package Detail
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During Lab Import, a formula may be used to determine whether to import the results for a Size 
Fraction sample.  This formula is associated with an analytical flow, but it can be defined differently for 
each laboratory that uses the analytical flow. 

•Analytical Flow: The unique name of the analytical flow.  This must be unique 
across both Size Fraction and Density Fraction flows.

•Global Analysis Only: Indicates that the preparation packages used will not 
have screens defined.

•Default for Standards: Indicates that this is the analytical flow that will be 
assigned automatically for any Standards that are created.  
Only one analytical flow can be flagged as the default.  This value can be 
changed at any time.  
This can only be checked if the analytical flow is flagged for "Global Analysis 
Only".

•Analyze the Global: Indicates that the Global Sample (original) will be analyzed.  
This is used to determine whether a Global Sample has had all of its results 
returned (for itself and its size fractions), and whether or not any results are 
expected for the Global Sample.

•Comments: Provide any extra information / description of the analytical flow as 
necessary.

Analytical Flow

•Laboratory list: This is a list of defined laboratories.  Select the labs that will be 
using this analytical flow.

•Lab Package Name: Based on the laboratories selected, a list of common lab 
packages will be offered from which to pick.  The Lab Package will provide the 
analytical details to the lab, and is used for validation during the Lab Import of 
results.

Laboratories
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If the selected Lab / Lab Package contains a mapping for a Mass column, where element_in_file is 
either MASS or WEIGHT, then it is also possible to implement validations based on that column, 
including: 

Validate Mass Total % when checked, provide a Total % Minimum and/or Total % Maximum to validate 
the sum of the mass values for each of the size fractions. 

Mass + Required Elements = Complete when checked, once a value is imported into each of the 
required columns, as defined by the Lab Package, and the Mass column, you can no longer import 
results for the sample. 

Allow Import when Mass = 0 when not checked, the mass value must be greater than 0 for results to 
be imported for the sample. 

Mass Validation Formula it is possible to create a formula that will be used for validating the mass 
value being imported during Lab Import.  

 

Using the View Manager 

The data for size fractions is stored in the Hole_Assay_Sample table as a normalized structure where 
each size fraction is a single record in that table.  In other applications, such as Studio, parent samples 
and size fractions data are imported with the information in a single record in the table.  These views 
provide a pivoting of the size fraction data and its analyzed elements into a flat table. 

[Maintain > Reference Tables > View Manager…] 
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▪ Multiple views can be created on the Central database, the user can name each view and 

each view can have a completely different set of columns in it. 

▪ Once a view is created it can be modified at any time by selecting new columns or options 

and clicking the ‘Save’ button. 

▪ As well as being able to open this window from the menu, it will be automatically opened 

when a preparation package is created 

 

 

Example View Columns 

Based on the example window and options in the new ‘View Manager’ window above, the following 
columns would be created: 

 

•Displays a list of current views. Views can be selected and edited, deleted and 
new views created.

Current Views

•Allows assay 'element' columns to be selected for inclusion in the view. If the 
'Sum' checkbox is selected for a particular column, a new calculated column will 
be created that contains the sum of the results for all size fractions for that 
column.

Elements

•Allows the user to select which size fraction names to create columns for

Screen Size Names

•Allows the user to select other columns from the hole_assay_sample table for 
inclusion in the view

Additional Columns

•Allows the user to specify whether NULL values for result columns will be 
replaced by another values. (ie -99)

Replace NULL

•Allows the user to specify if calculated columns will be created in the view for 
Stoichiometric (Verfication Formula) values.

Include Verification Columns
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Au_gpt_lab_+8mm 
Ag_gpt_lab_+8mm 
Cu_per_lab_+8mm 
Mass_per_lab_+8mm 
Sg_gcm3_lab_+8mm 
 
Au_gpt_lab_+1mm-8mm 
Ag_gpt_lab_+1mm-8mm 
Cu_per_lab_+1mm-8mm 
Mass_per_lab_+1mm-8mm 
Sg_gcm3_lab_+1mm-8mm 
 
Au_gpt_lab_-1mm 
Ag_gpt_lab_-1mm 
Cu_per_lab_-1mm 1 
Mass_per_lab_-1mm 
Sg_gcm3_lab_-1mm 
 
Au_gpt_lab_Sum 
Ag_gpt_lab_Sum 
Cu_per_lab_Sum 
Mass_per_lab_Sum 
Sg_gcm3_lab_Sum 

 
+8mm_Stoich 
+1mm-8mm_Stoich 
-1mm_Stoich 
 
Rock_Type_Code 
Hole_Number 
Analytical_Flow_Name 
Prep_Package_Name 

 

DENSITY FRACTIONS  The subsample is extracted from the original sample during the sample 
preparation process by float/sink analysis.  The number of subsamples depends on the analytical flow 
which specifies the number and the relative densities of the immersion liquids.  One original sample 
can be split into many density fraction samples, and they are related to the original sample (which 
becomes the parent sample). 

The configuration required for usage of size fractions includes: Density Packages, Analytical Flows 
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•Relative Density Name:The name of the density immersion, unique within this 
package.

•Sink RD: The sink relative density.

•Float RD: The float relative density.

•Method Used: Description of the method used in performing this analysis.

•Comments: Provide any extra information / description of the relative density, 
as necessary.

Density Package Detail
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•Analytical Flow: The unique name of the analytical flow.  This must be unique 
across both Size Fraction and Density Fraction flows.

•Comments: Provide any extra information / description of the analytical flow as 
necessary.

Analytical Flow

•Laboratory list: This is a list of defined laboratories.  Select the labs that will be 
using this analytical flow.

•Lab Package Name: Based on the laboratories selected, a list of common lab 
packages will be offered from which to pick.  The Lab Package will provide the 
analytical details to the lab, and is used for validation during the Lab Import of 
results.

Laboratories
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PLANNED DRILL HOLES 

This module is used to store and define the planned drilling activity for a project.   The information in 
this table is frequently imported to the Central, and then the data is transferred to the Local databases, 
where users generate the holes as they are drilled.  To implement this functionality, administrators can 
configure which tables will have data created automatically when the hole is generated, depending on 
the Hole Type.   

[Maintain > Reference Tables > Hole Type Generation...] 

 

 

Double-clicking on a Hole Type will open the window that allows for the selection of tables: 
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Since planned drill holes can be created in any database, administrators may want to ensure that each 
of the hole numbers follow a specific naming convention.  This can be configured, and when the user 
synchronizes with the Central, these planned drill holes will be updated with a proper name and 
transferred to the Central database.  

Note that this does not refer to the name of the actual generated drill hole, but to the records in the 
DHL_PLANNED_DRILLHOLES table that have a status of “PLANNED”. 

[Maintain > Reference Tables > Planned Hole Numbering Templates…] 
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Based on the example above, the first planned drill hole in Project 2005, of type DD will have the hole 
number renamed to: 2005-DD-0010000  

And the first planned drill hole in Project 2004, of type DD will have the hole number renamed to:  
2004-DD-0000001 

•DB Field: checking this will populate the dropdown with columns available 
within the DHL_PLANNED_DRILLHOLES table.

•Separator: checking this will populate the dropdown with a hyphen and an 
underscore.

•(SEQUENTIAL NUMBER): the dropdown always contains this value so that it can 
be selected regardless of whether you initially chose DB Field or Separator.  
When selected, the other checkboxes are reset to NULL, and you specify a size.  
Numbers will be padded with leading zeros to make the selected length.

•Upper: this option will ensure that data is converted to upper case, instead of 
using the case entered in the database.

•Length: this option will limit (truncate) data from fields, or pad sequential 
numbers with leading zeros.

Hole Naming Template Details

•Depends on the Details selected above, but will include the ability to set a 
starting sequence number for each unique db-field combination

Data Combinations
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LAS ADMINISTRATION 

This administration window allows for the configuration of the lists that support the LAS module in 
DHLogger. 

 

 

EQUIPMENT AND RIG CONFIGURATION  From this window Administrators can create Equipment 
reference lists that can be used to create the Rig reference list, which outlines the components used to 
take the readings in the drill hole.  Also, they can associate files that detail calibration tests for each 
piece of equipment. 

[Maintain > Reference Tables > LAS Administration > Equipment and Rig Configuration…] 
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 To create a new Equipment Category, select the ‘Equipment’ branch and click the New 
button. 
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To edit the structure (Add Columns, Delete Columns, Create Table), open the Reference Table editor: 

[Maintain > Equipment Reference Tables > Define Reference Tables…] 

 

 

To add, delete or edit codes in the reference tables, simply select the Equipment 
Category in the tree (e.g. Cable) and click the New button. 

[Maintain > Equipment Reference Tables > Manage Data…] 
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To add a Calibration file for a specific equipment code, select the code (e.g. C500) and 
then click the New button. 

[Maintain > Calibration Table > Manage Data…] 

 

 

 

Additionally, the Calibration Table can be configured with custom columns. 

[Maintain > Calibration Table > Define Calibration Table…] 
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To complete configuration of the Rig Table, navigate to the following menu: 

[Maintain > Rig Table > Define Rig Table…] 

 

 

To create new Rigs, once configuration is complete, simply select the "Rigs" entry in the 
tree and click the New button. 

[Maintain > Rig Table > Manage Data…] 

 

 

LAS IMPORT DEFINITION  This is similar to the custom lab import templates, where Administrators 
can define the data that is imported, and from what locations.  With LAS files, there is a standard file 
format (Log Ascii Standard format), so the template definition is limited in that respect. 

[Maintain > Reference Tables > LAS Administration > LAS Import Definition…] 
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•Name, Description: A unique name and long description of the Template

•Import: not editable, indicates this is a LAS Import

•File Type: Version of LAS file this template will support.  It must match the file that is 
selected for preview, which populates the Source columns.  

Template

•Assumes that the LAS Header table has been configured with additional columns

•Intially, no rows showing, must select "+" button in the header to add a mapping.

•Destination: a picklist containing the columns in the DHL_LAS_HEADER table

•Source: a picklist containing the columns in the "WELL INFORMATION" section from the 
selected LAS file

LAS Header Mappings

•Initially, no rows showing, must select "+" button in the header to add a mapping

•Destination: a pick list containing the columns in the DHL_LAS_DATA table

•Source: a picklist containing the columns in the "CURVE INFORMATION" section from 
the selected LAS file

LAS Data Mappings

•Select a file to assist with the creation of the Template, it must be the same version as 
the File Type of the template

•Used to populate the Source Columns

Import File Preview
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SCINT IMPORT DEFINITION  This is also similar to the custom lab import templates, allowing 
Administrators to define the data that is imported, from what locations, and into which columns.  This 
imports the readings from a handheld scintillometer that is scanning the drill core. 

[Maintain > Reference Tables > LAS Administration > Scint Import Definition…] 

 

 

•Name, Description: A unique name and long description of the template

•Import: not editable, identifies template as a Scint Import

•File Type: CSV, or tab-delimited TXT file

Template

•Assumes configuration of DHL_LAS_SCINT_HEADER table

•Initially blank, must click "+" button in the header to add rows

•Picklist: destination column in DHL_LAS_SCINT_HEADER table

•Row, Column: cell location of information from import file; can manually enter or drag/drop from 
file

Location of Header Information

•Initially blank, must click "+" button in the header to add rows

•Picklist: destination column in DHL_LAS_SCINT_HEADER

•Row, Column: cell location of information from import file; can manually enter or drag/drop from 
file

Location of Data

•Select a file to assist with template creation

Import File Preview
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SAMPLE TAG DESIGNER  

This window allows for the configuration of custom sample tags.  Administrators can define tags for 
DHLogger and Sample Station, special tags for the Laboratory, and then distribute these tags to users 
through synchronization. 

Administrators can define the following properties of the tag: 

• Tag Height 

• Tag Width 

• Columns, and where they appear on the tag 

• Font Name, Colour, and Size 

• Static Text 

• Custom Images 
 

[Maintain > Sample Tag Designer…] 
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DESTINATION COMPOSITOR 

This module allows users to create composites of samples, and from that information, assign a 
destination to the composite (e.g. High Grade, Low Grade). 

•Name: A unique name to identify the sample tag.

•Module: DHLogger / Sample Station.  Identifies where the tag will be available 
for selection, filters the available sample columns.

•Height, Width: The measurements of the tag.

•Margin: The height/width of the margin for the tag.

•Unit of Measure: The unit of measure for the specified height/weight/margin 
of the tag.

Sample Tag Configuration

•Column Name: Identifies the name of the column available to add to the tag.

•Data Type, Width, Decimals: Identifies the definition of the column.

•Module: Visible for DHLogger tags only, identifies the module where the 
column is found, since both ASSAY and COMPOSITE samples will be available in 
DHLogger.

Sample Columns

•A rich-text section to format the sample tag.

Sample Tag
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DESTINATION COMPOSITE COLUMNS  There are two types of columns that can be created.  Result 
columns are columns that are selected from existing columns in the HOLE_ASSAY_SAMPLE table, and 
Storage columns, which are selected from existing columns in the DRILL_HOLE table.  Result columns 
are never editable (display only). 
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DESTINATION COMPOSITE COLUMNS FORMULAS  This list defines the formulas that are used to 
calculate a result based on the results of the composite calculations.  For example, a custom column 
may be added to the DHL_DESTINATION_COMPOSITE table (through the Custom Tables tile) called 
'Calc_Destination'.  For this column, many formulas may be created that will set values for this field 
based on the results of the composited columns. 

 

•Type: Result / Storage. Defines what columns will be available in the 'Name' picklist -
where the data will be pulled from

•Name: Picklist, populated from HOLE_ASSAY_SAMPLE for Result columns or 
DRILL_HOLE for Storage columns.

•Top Cut: Available to Result columns only, indicates that a calculation should be created 
using an upper limit bound

•Equivalence Factor: Available to Result columns only, indicates that a calculation should 
be created using the specified equivalence factor

•Equivalence Formula: Available to Result columns only, indicates that a calculation 
should be created using the specified formula

•Visible: Yes / No.  Whether the column is displayed in the Destination Compositor 
windows.

Formula Tree: operators / functions / columns used to help create the Equivalence 
Formula

Depending on the information specified for result columns, the following columns may 
be created in the DHL_DESTINATION_COMPOSITE table:

•result_column_COMP  (always created - calculation is a static average formula)

•result_column_TOPCUT

•result_column_FACTOR

•result_column_EQV

•result_column_EQVADJ

•result_column_ADJ

Composite Columns



 

3/31/2023 Fusion Administrator 110 
 

As shown, many formulas can be created for the same 'Result Column', and they will be applied in the 
Order that is specified. 

 

 

DESTINATION COMPOSITE ADJUSTMENT COLUMNS  This list defines the formulas that are used to 
calculate an adjustment based on the results of the composite calculations.  For example, an 
adjustment column might contain a formula to calculate based on the EQV or COMP values, and this 
formula might be specific to meeting certain criteria on another column, such as Mine_Name = 'CM'. 
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As shown, there can be formulas based on several columns, and the ranking determines the 
precedence. 

 

 

CUSTOM EXPORT DESIGNER 

Custom exports can be created using a saved Fusion Connex workspace. 

[File > Custom Export Designer…] 
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DEPTH ADJUSTMENT TEMPLATES 

DHLogger has a module which allows for the visual adjustment of depth data.  Administrators define 
templates once that will be repeatedly used, making the Depth Adjustment tool easier to use. 

The creation of Depth Adjustment Templates is performed in the Logging Style Administration window, 
by selecting a Logging Style, expanding the Tabs folder, and double-clicking the “Depth Adjustment” 
entry. 

To create a new template, use the New Template button from the footer toolbar 
and enter a unique name and a description. 

•Export Name: the name of the export, which will be seen as the menu item 
(under Export).

•Export Source: choice of Fusion Connex Workspace or Report Manager Export

•Fusion Connex Workspace: the workspace used to define the tables and 
columns that will be exported.

•Report Manager Export: the export, defined in Report Manager, used to define 
the tables and columns that will be exported. 

•Export Select Objects: Drill Holes / Surface Samples / Maps.  The objects that 
are available to be selected in the Export window.

•Application to Access Export: DHLogger / Sample Station.  The applications 
from which the export will be available under the Export menu.

Export Definition
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LINKED TABLE SYNCHRONIZATION 

In DHLogger, tables can be linked and kept synchronized by a ‘Source’ table.  Data entry is performed in 
the source table and dependent tables have rows inserted/updated/deleted accordingly. This 
synchronization can occur automatically or manually depending on the configurations made in Fusion 

•Template: select the template name to be configured

•Hole Type: PRIMARY / REFERENCE x.  To adjust data, reference data can come 
from the PRIMARY hole (same hole as adjustment data) or one or more other 
holes (REFERENCE holes, which will need to be selected at the time of use in 
DHLogger)

•Tables: a tree of tables and columns that can be dragged to the Reference or 
the Adjustment section.  The tables shown are only those with depth 
information, and only those associated with the Logging Style.

•Reference: tables/columns dragged to this section will define the data that will 
be displayed in the Depth Adjustment tool to assist with the changing of the 
Adjustment Data.

•Adjustment: this data comes from the PRIMARY hole and defines which table 
will have its depths adjusted.

Depth Adjustment Template
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Administrator.  Access to this configuration depends on the “Allow Table Linking” setting in the System 
Preferences (or Business Unit Preferences). 

[Maintain > Reference Tables > Sample Definitions > Table Linking Configuration...] 

 

 

Select a Business Unit and Source Table to define the linked tables that will be updated when 
synchronization occurs. 

NOTE: The Sample Type drop down is required if the Source Table is ‘Hole_Assay_Sample’. Only sample 
types belonging to the ‘Original’ sample type category are available for selection. 

   

Use the 'Add' button to add a new table to the configuration. 

Use the 'Delete' button to remove tables from the business unit / source table 
configuration. 

Use the 'Edit' button to modify the default values for the Required Columns in the 
dependent table. 
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The Table list will vary depending on the Source Table that is selected: dependent table must have rules 

(allow gaps, duplicates, overlaps) that are the same or less restrictive than the source table that is 

selected. 

The ‘Synchronization Type’ dropdown identifies whether the linked table will automatically be kept in 

sync with the source table, or if the user will be required to manually synchronize from within a window 

in DHLogger. 

Required columns will appear below the destination table. The defaults for these required columns must 

be specified before the table can be linked.  
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When configuring HOLE_ASSAY_SAMPLE as a dependent table, the Sample_Number column has two 

choices for a default value: Automatic, which populates as hole_number + “-001” suffix; or Sample 

Naming Template, which will use the template associated with the sample type selected in the second 

required field’s dropdown. 

Also, it should be noted that only INSERT actions will be synchronized in the hole_assay_sample, and 

there is an attempt to make this clear in the configuration window.  
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MISCELLANEOUS CONFIGURATION 

COLUMNS LIMITED BY LOGGING STYLE  

This configuration is available after enabling the setting in the System Preferences window.  When it is 
first enabled the application will initialize the configuration for each Logging Style with all columns 
assigned in each table that is assigned.   

 

 

After that, the Administrator can go to the Logging Style Administration window, select a Logging Style, 
and then expand the Tabs folder to view each table’s assigned columns.   

By double-clicking on the table name, the Administrator can then check/uncheck the columns that 
should be available to the Logging Style. 
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REFERENCE CODES TO BUSINESS UNITS  

This configuration is available after enabling the setting in the System Preferences window.  When it is 
first enabled, nothing has been configured.  When a list does not have any codes associated with a 
Business Unit, then all codes are available to all business units.  Once the first code in a list is associated 
with a business unit, it is assumed that the list is properly configured for all business units.  

[Options > System Administration > Reference Codes to Business Units…] 
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▪ When this system preference is not enabled, the only available list is “ROCK_TYPES”. 
▪ Select a Reference List from the dropdown to begin configuration. 
▪ Select one or more codes (multi-select with CTRL and SHIFT is available) and drag to a Business 

Unit in the left-hand window. 
▪ Using the Report button, a report can be created that will show all codes in all lists that are 

assigned to a Business Unit. 

 

BUSINESS UNIT PREFERENCES 

One of the strongest features of Fusion is its ability to handle a system for a global organization which 
may involve a variety of languages and business rules; this is handled using Business Units and Logging 
Styles.  The Business Unit Preferences window is the location for the configuration of these various 
settings. 

By default, each business unit will use the Global Configuration for tables and columns.  To customize 
settings, such as tab titles, column titles, default values, etc., an Administrator would open the Business 
Unit Preferences window, select the Business Unit that needs to be configured, and uncheck the “Use 
Global Table and Column Configuration”. 
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Once the setting is unchecked, tables can be selected and have certain settings changed: 

▪ Tab title 
▪ Presentation Style 
▪ OC Calculation Method 
▪ Allow Overlaps 
▪ Allow Duplicates 
▪ Allow Gaps 
▪ Data Must Start at Zero 
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Individual columns can also be selected, and its settings can be changed, if they apply: 

▪ Column Title 
▪ Decimals to Show 
▪ Default Value 
▪ Inherit Values 
▪ Is Required 
▪ Min Value 
▪ Max Value 
▪ Lookup Display Column 
▪ Overlap Validation 
▪ Dup Validation 
▪ Gap Validation 
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In the Reference Lists tab, some reference lists can be configured to display only some of its columns. 
This is achieved by selecting the Reference List from the dropdown and checking the columns to 
“Display In List”.   This would be useful to handle multiple languages.  A reference list can be created 
that has a code and a description field for each language that needs to be supported.  Each language 
could be its own Business Unit, and the lists could be configured accordingly. 

NOTE: ROCK_TYPES is included as a configurable list, but at this time customization does not apply to 
the “tree” that is used in the Major/Minor lithology window.  It does, however, apply to a custom 
column that is linked to the ROCK_TYPES table. 
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System Preferences can also be customized, allowing for each business unit to set up its own business 
rules.  The image above shows the configurable settings, including the window that allows for each 
business unit to rank Test Type codes; ranking Coordinate Types and customizing Lithology details (rock 
type color, short and long description) are also available. 

If an administrator has made changes to System Preferences for a Business Unit, but then decide the 
Business Unit should have the same settings as the Global system, the “Restore Global Preferences” 
button can be used to remove all the customized System Preference settings for the selected business 
unit. 
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This window also allows Email Settings to be configured by Business Unit.  Administrators can change 
both the default email program (Outlook / SMTP), and the notifications / notified users.  

 

CONTEXT-SENSITIVE LISTS 

Administrators can configure fields with dropdown lists in a table to be dependent on the value in 
another dropdown list.  These are known as context-sensitive lists. 

In the Column Maintenance window of the second (dependent) column, the “Context Sensitive” field 
would be checked.  When this is enabled, a “Configure” button appears.  This is where the dependency 
would be created. 
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A single column can have a different context created for each business unit.  An Administrator would 
select a business unit from the tree on the left and click the New button to create a new context. 
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At this point, the “Context Column” would be selected from the picklist, which is a list of the other 
columns in the table that are linked to dropdown columns.  This column’s data will define what codes 
appear in the picklist for the column that is being edited. 

NOTES:  

For interval-related custom tables, Administrators can select ROCK_TYPE_CODE (INTERVAL), which will 
use the major/minor lithology’s rock type to determine the values that will be available in the picklist. 

For most tables, Administrators can also select PROJECT_NUMBER (PROJECT) which will use the Project 
to which the Drill Hole or Surface Sample belongs to determine the values that will be available in the 
picklist. 

 

 

Once a context has been created, the tree will be drawn with the codes in that list (if the “Reference 
Codes to Business Units” system preference has been enabled, the list will only show the codes that 
the business unit has been assigned). 

Under each code, the Administrator would now drag/drop codes from the right to the tree on the left.   

NOTE: codes belonging to one business unit can only be dragged to a context belonging to the same 
business unit.  

PROCESS FLOWS 

Validation of parts of a drill hole or surface sample, locking it down to prevent changes to its data is 
handled through the creation of Process Flows.  A Process Flow defines the group of tables that are 
treated as a unit of work that can be validated and authorized. 

Process Flows are created in the Logging Style Administration window, as they are a sub-grouping of a 
logging style’s assigned tables. 
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To create a process flow, expand a Logging Style, and select the “Process Flows” entry, 
then click the New button. 

 

 

The tables that will be available to the Process Flow are only the tables that have been assigned to the 
Logging Style to which this process flow belongs. 

Once a process flow has been created, to be used it must first be assigned to a user.  This is achieved by 
opening the User Administration window, selecting the user, expanding the Logging Style, and double-
clicking on the “Process Flows” entry. 
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INSTRUMENT CONFIGURATION 

Geologists can connect directly to instruments and accept values directly into the Drill Hole module in 
DHLogger. Administrators can define connection properties and parsing behavior in the Instrument 
Configuration windows. 

[Maintain > Reference Tables > Instrument Configuration > Connection Properties…] 

 

This window defines how DHLogger will connect to the instrument to receive data. 

 

[Maintain > Reference Tables > Instrument Configuration > Data Parsing…] 

 

Hit the ‘New’ toolbar button to add new parsing information or double-click to edit existing parsing 
information. The ‘Delete’ toolbar button allows you to delete parsing information for the selected 
instrument. 
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Below is a summary of the columns included and how they are used to define how data is received 
from the instrument. 

Field Name Description 

Instrument Identifies the instrument associated with the parsing instructions. 

Landmark Prefix The first character or phrase DHLogger will search for to identify the 
portion of data to receive from the instrument. 

Landmark Suffix The last character or phrase DHLogger will search for to identify the 
portion of data to receive from the instrument. 

Row Number If the data sent from the instrument occurs over multiple lines, the 
row number identifies the row of data to receive. 

Search Direction The search direction identifies if DHLogger searches from left to right, 
or right to left when identifying the landmarks. 

Raw Data This box accepts the raw data sent from the instrument for testing 
purposes. 

Numeric Test Result This box contains the test result for receiving the parsed instrument 
value into a numeric column. 

String Test Result This box contains the test result for receiving the parsed instrument 
value into a string column. 
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QC MINIMUM THRESHOLD 

A setting / value that is used in the QC Generator module in DHLogger (Central).  It represents the 
minimum number of QC samples that must exist in the DHL_QC_SAMPLES table that are awaiting 
results, ensuring that there is a valid Quality Control program in place in the software. 

[Maintain > Reference Tables > QC Minimum Threshold…] 

 

OBJECT AUDIT CODES 

This list maintains a valid set of reasons for performing various actions in the applications.  These 
reasons are usually tracked in the audit tables when the actions occur. 

There is a static list of Actions that may require reasons to be entered. Each reason must be unique 
(regardless of the Action). 

[Maintain > Reference Tables > Object Audit Codes…] 
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STATUS CHANGE OPTIONS 

This list is used to store the valid options for changing Sample Status or Batch Status in the Batch 
Authorization module in DHLogger. 

[Maintain > Reference Tables > Sample Definitions > Status Change Options…] 

 

 

 

SAMPLE NAMING TEMPLATES 

Administrators can create a sample naming template for each Logging Style, for each Sample Type, if 
desired.  These naming templates can ensure that there is a standard naming convention used in the 
database. 

Administrators can create the many templates, then assign them in the Logging Style Administration 
window by double-clicking on the Sample Type under the specific logging style and selecting the 
desired template from the list. 

[Maintain > Reference Tables > Sample Definitions > Sample Naming Templates…] 
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▪ Templates can be created for DHLogger samples, Composite samples, Surface Samples, and QC 
samples. 

▪ They can be created with a combination of Database Fields, Separators (hyphens, underscores), 
Static Text and Sequential Numbers. 

▪ There is also a setting to have the sequence reset for each drill hole. 

 

COMPOSITING CUTOFF VALUES 

This list is used in the Worksheet, accessible in DHLogger from the Samples tab.  It defines some cutoff 
values (maximums) that could be used when performing the average calculations in the worksheet.  
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REQUEST / RESULT MAPPING 

This list is used to make a connection between a custom storage field with checkbox style and a Result 
column.  With this connection, the checkbox field could be used to identify whether a specific element 
was to be assayed.  Then a report could be produced which would identify samples where the 
checkbox is checked, but the result column is still null (no results returned yet).  
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VALIDATION RULES GROUPS 

Administrators can define groups to combine a set of validation rules to be run for a specified module.   

 

[Maintain > Validation Rules > Validation Rules Groups…] 

 

 

Hit the ‘New’ toolbar button to add groups or double-click to edit existing groups. The ‘Delete’ toolbar 
button allows you to delete the selected group. 

 

Validation Rules Groups can be limited by Business Unit on the Reference Codes to Business Units 
window if the Reference Codes Limited by Business Unit system preference is enabled. 

 

[Options > System Administration > Reference Codes to Business Units…] 
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VALIDATION RULES 

Administrators can configure validation rules to maintain the desired workflow and rules within the 
system.  These rules can be used to validate data at a logging, reporting, or authorization level. 

 

[Maintain > Validation Rules > Validation Rules…] 

 

 

Hit the ‘New’ toolbar button to add validation rules or double-click to edit existing rules. The ‘Delete’ 
toolbar button allows you to delete the selected validation rule. 
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Below is a summary of the columns included and how they are used to define how data is received 
from the instrument. 

Field Name Description 

Name Identifies the name of the rule 

Enable Rule Identifies if the rule will be executed when validation rules are run 

Rule Table Defines the primary table for the rule 

Rule Description A description of the current rule 

Validate at Logging Level Identifies if the rule will be executed when data is being logged or 
imported 

Set Colour On Failure Identifies if the Colour Column text colour will be changed to the 
specified colour if the validation rule fails during logging 

Colour Column Identifies the column whose text colour will be changed when a 
validation rule fails based on the specified colour from the Set Colour 
On Failure column 

Display Message On Failure Specifies if a message is displayed when the validation rule fails 

Rule Message The message to be displayed when the rule fails 

Validate at Reporting Level Identifies if the rule will be executed when the validation report is 
run 

Validate at Authorization 
Level 

Identifies if the rule will be executed when a hole or sample are 
authorized 

Halt Validation on Failure Defines if the application will continue validating rules and will allow 
the user to continue with certain actions (quick transfer, leaving the 
current tab, adding new records, etc..) 

Validation Criteria This is the logic for the actual rule that will be executed.  The format 
for the rule is standard SQL. 

 

 

VALIDATION RULES CRITERIA  The validation rules criteria is defined using standard SQL logic.  The 
criteria is the WHERE clause of the SQL statement.  A rule is considered to fail when results are 
returned that fit within the specified criteria. 

 

To view a list of available tables and columns for use in the validation criteria, click 
the Column button 

 

 
To view a list of available functions for use in the validation criteria, click the 

Function button 
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Click the Paste button to copy your selected Column, Function, or last item from 
your clipboard into the Validation Criteria at the current cursor position.  The Ctrl-
V hotkey will also perform the Paste. 

 

Click the Check Syntax button to verify your Validation Criteria is syntactically 
correct and can be executed.  If not, a message will be displayed.  Syntax is 
checked when hitting the OK button and must be valid to save the Validation Rule. 
  



 

3/31/2023 Fusion Administrator 138 
 

 

SELECT A COLUMN  This is a list of available tables and columns for use in the Validation Rules Criteria. 

 

Select a table from the pick list to view a list of all available columns within the selected table.   

 

Click the Insert button to insert the column at the position of the cursor within 
the Validation Criteria statement.   

 

Click the Copy button to copy the column to your clipboard to paste into the 
Validation Criteria. 
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SELECT A FUNCTION  This is the list of the most used functions and expressions available to use in the 
Validation Rules Criteria. 

 

 

Select a function from the list.  The Data Description gives a summary of how the function is used. 

 

NOTE: The Function list is only a small subset of the available functions supported.  We have just listed 
the most used functions. 

 

Click the Insert button to insert the function at the position of the cursor within 
the Validation Criteria statement.   

 

 

Click the Copy button to copy the function to your clipboard to paste into the 
Validation Criteria. 
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ASSIGN VALIDATION RULES TO GROUPS 

Administrators can associate rules with a selected group. 

 

[Maintain > Validation Rules > Assign Validation Rules to Groups…] 

 

 

Drag rules back and forth between the Assigned Rules and All Available Rules sections for the selected 
group. 

 

EXTERNAL DEVICE MANAGEMENT 

This list is used to manage devices (phones) and QuickLogger licenses. The device ids are referenced 

during the External Transfer In and Out processes in DHLogger and Sample Station. 

 


